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Introduction

Digitalization has transformed design radically in the past few decades. In the early 60’s, architect 

Utzon had to struggle to find a feasible structural solution for the free-form curved surface that 

he designed for the Sydney Opera house. Four decades later, Frank Gehry could create very 

complex geometric models with ease. It is clear that the digital revolution is producing a similar 

revolution in design by providing new intellectual tools (Mitchell, 1999). Nevertheless, it is always 

a challenge for designers to learn and employ the new technologies to their practice. Two groups 

of people are involved in this revolution: the developers (software engineers) and the users 

(designers). The revolution cannot exist if either one is not participating. However, often a discon-

nection exists between them that may slow down the process.

The disconnection can occur in three ways: vocabulary, concept and categorization. Software 

engineers have used vocabulary that is elusive to designers. Designers are familiar with materi-

als, vinyl, carpet, plastic laminate and paint, yet very few know Raytrace, Blinn, Phong and 

Anosotropic. They also know form, shape, contour and volume, but not editable mesh, NURBS, 

normal, Boolean and polygon. Furthermore, not only the terms in the two professions are differ-

ent, but also the fundamental concepts. For instance, the designer’s concept of materials is 

more limited than the software engineer’s concept of texture mapping. For software engineers, 

texture mapping is “a method of varying the surface properties from point to point in order to 

give the appearance of surface detail that is not actually present in the geometry of the surface” 

(Ebert, Musgrave, Peachey, et. al., 2002). It was “introduced as a method of adding to the vis-

ual richness of a computer generated image without adding geometry” (Turk, 1991). Software 

engineers employ texture mapping as a means to reduce the amount of time for computation. 

Lighting effect, shadow, even structure can all be applied to the surface as texture mapping. 

However, it is evident that treating lighting, shadow or structure as textures is a foreign concept 

for designers who have the tendency to think that textures can only mean materials as they 

normally do in the analogue world. As a result, many of the functions created by the engineers 

are not used by designers. In addition, many designers also encounter obstacles while choosing 

and learning new technologies due to the vast number of choices - AutoCAD, 3DS Max, Maya, 

Rhino, Form-Z, SketchUp, just to name a few. Therefore, comparative studies of the recent 

development in 3D visualization are needed in order for designers to take full advantage of those 

new technologies. 
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Objective of Study

The goal of this paper is to establish links between the two bodies of knowledge so that design-

ers can utilize the new digital tools more effectively. The focus of this paper is on the common-

alities and differences of material and texture mapping techniques among 3D rendering softwares, 

namely 3DS Max (including Viz), Maya, AutoCAD, Rhino, Revit and SketchUp. Three aspects of 

material mapping techniques can be compared among these 3D rendering products: vocabulary, 

concept and categorization. However, this paper will discuss only the vocabulary in material and 

texture mapping used among those softwares. Future study on the two other aspects of mate-

rial and texture mapping among the current 3D softwares is recommended. The result of this 

comparative study may help software engineers to better understand how designers view and 

use computer graphic products.  

The Concept of Texture Mapping vs. Material 

The texture mapping technique has progressed dramatically since the beginning of 3D rendering 

products. It has become more complex as it continues to develop. However, the foundation of 

texture mapping has not changed. Paul Heckbert summarized the development on texture 

mapping in 1986. He stated “The possible uses for mapped texture are myriad. Some of the 

parameters that have been texture mapped to date are, in roughly chronological order: 

surface color

specular reflection

normal vector perturbation (bump mapping)

specularity transparency

diffuse reflection

shadows, surface displacement

local coordinate system” (Heckbert, 1986)

These texture mapping techniques and terminologies are still used today. Software engineers in 

computer graphics are familiar with the development and terminologies. Nevertheless, it has not 

been easy for designers to understand the terminologies used in 3D software industry without 

taking lessons beyond the scope of design. Some terminologies coming from the name of a 

person who has had significant contribution to the software industry are especially unfamiliar to 

designers. For instance, “Phong” and “Blinn” are surnames of two important pioneers in com-

puter graphics: Bui Tuong Phong (History of School of Computing at University of Utah) and Jim 

Blinn (Microsoft research). Designers could have guessed that those material balls they are 

struggling with are named after people; however, they would not have known any of computa-

tional methods and rendering properties. Some functions have never been fully understood by 

designers who are using those 3D graphic products. Designers classify 3D graphic products as 

intuitive and indirect. In general, high-end design softwares are more expensive and less intuitive. 

They can produce superior rendering results; however, they require numerous hours of training 

in order to operate properly. As a result, design firms are reluctant to purchase expensive com-

mercial 3D packages and send their personnel for training; instead, they turn to less expensive 
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and intuitive 3D products (Acheson & Hardin, 2003). The question to ask is how intuitive are 

they? Why is one 3D rendering software package more intuitive than another? Merriam-Webster 

online defines the term “intuition” as “quick and ready insight,” “immediate apprehension or 

cognition,” and “the power or faculty of attaining to direct knowledge or cognition without evident 

rational thought and inference.” Nevertheless, no previous research has compared the current 

3D products in a sense of how intuitive they are and how they are designed in terms of vo-

cabulary, concept and categorization. This paper is the foundation of research on intuitivism of 

current 3D graphic products. However, it will not directly answer the question of whether a 

given software is intuitive or not.      

Research Methodology

This research is a descriptive study. It seeks to describe the commonalities and differences of 

vocabulary used among current 3D rendering softwares, namely 3DS Max 2009, Maya 8.5 

personal learning edition, AutoCAD 2006, Rhinoceros 4.0, Revit Architecture 2008 and Google 

SketchUp 6 relevant to designing materials. The versions were chosen entirely based on the 

availability. However, the author believes that the different versions should not affect this research 

greatly. This paper also compares the complexity of material and texture mapping technique 

among those softwares.

Prior to this study, the author is familiar with how to design materials and apply textures to ma-

terials in 3DS Max (including Viz) and AutoCAD, but not in Maya, Rhino, Revit and SketchUp. 

For the purpose of this study, the author developed a systematic method of determining where 

to find information that is relevant to this research. The procedures are: 1) Go to Help (Help is 

available in every software) and type in three phrases relevant to this research: material, texture, 

mapping; 2) Count the number of topics found through search that are relevant to designing 

materials; 3) Read all the topics and learn how a basic material is designed; 4) Identify terms and 

find the common one shared by many softwares and the unique one used by one software; and 

5) Identify terms shared by designers and software engineers.

The systematic procedure is comprised of two aspects of research: data collection (Step 1-3) 

and data analysis (Step 4-5).         

Data Collection

The author followed the data collection procedure developed from research methodology and 

typed “material,”“texture” and “mapping” into the search from Rhinoceros 4.0, Revit Architecture 

2008, Google SketchUp 6, 3DS Max 2009, Maya 8.5 personal learning edition and AutoCAD 

2006. 

The results of data collection and methods of designing materials are: 

Rhinoceros 4.0 evaluation

Through search, the author found four topics related to designing materials: Material mapping 

options, material properties, object properties, and texture mapping properties. The author found 

no unique terms in Rhino. In addition, all the terms and phrases used in Rhino are common in 
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Figure 1
Basic Material Properties in Rhinoceros 4.0
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Figure 2
Explanation of creating a material appearance style in Rhinoceros 4.0
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English and can be understood by designers without special training. For instance, gloss finish 

and transparency are common words and can be found from www.merriam-webster.com. The 

method of designing a basic material in Rhino is explained below.   

 

“Basic Material Properties (see Fig. 1)

If you select the Basic option for assigning render properties, you can set the color, finish, trans-

parency, texture, and bump for use by the built-in Rhino renderer.

1) Name

Names the material.

2) Color

The color used to render surfaces, polysurfaces, or polygon meshes. To change the render color, 

click the color swatch and select a color in the Select Color dialog box.

The color option does not affect the select wireframe display. To change the color of the wireframe 

display, change the color of the object’s layer or set the color on the Object page.

3) Gloss color

Sets the highlight color. Note: Set the highlight color to match the base color for metallic mate-

rials. Set the gloss color to white for plastic materials.

4) Gloss finish

Adjusts the highlight from matte to glossy.

5) Texture

Defines the name of a bitmap file that will be mapped onto the surface when you render the 

scene.

6) Properties - Transparency

Adjusts the transparency of an object in the rendered image. 

7) Properties - Bump bitmap

Defines the name of a bitmap file that will be mapped on the surface as a bumpmap when you 

render the scene.

8) Properties - Environment

Defines the name of a bitmap that will be mapped onto the surface as though it were being 

reflected.” (This information was found from Rhinoceros Help) 

Revit Architecture 2008

The author followed the research procedure and typed “material” into the search from Revit 

Architecture 2008 Help. 203 topics were found by Revit as relevant topics for material; how-

ever, the author investigated all 203 topics and found many are repeated topics. In fact only four 

topics are relevant to designing a material: creating a material appearance style, use materials 

with AccuRender Textures that reference Bitmaps, Raytrace, and specify Raytrace setting (see 

Fig. 2). Search for “texture” and “mapping” did not yield any new topics regarding designing a 

material.

Han
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The author found two unique terms in Revit through search procedure: AccuRender and Raytrace. 

They are not common words in English. It is possible that more unique terms exist in Revit but 

were not found through this search procedure. However, the number should be very limited. 

Further investigation led to a conclusion that AccuRender is unique to Revit, and Raytrace is a 

common term by shared many 3D rendering softwares. The method of designing a basic mate-

rial in Revit is explained below (see Fig. 3). 

“When you assign materials to elements, some material parameters are defined in Revit Archi-

tecture (such as color). Other material parameters (such as texture) are defined by AccuRender. 

If the AccuRender textures use bitmaps, then 3ds Max is able to successfully render the textures 

on assigned surfaces.

In Revit Architecture, click Settings menuMaterials to edit materials

More complex textures, however, may be defined using AccuRender procedures for combining 

materials. (For example, the marble procedure combines a Base material with a Vein material.) 

These are called procedural materials.

If the AccuRender materials are procedural, 3ds Max translates the material at the most basic 

level. It displays colors and other settings defined by Revit Architecture but ignores the Ac-

cuRender procedural texture.

paper #C2#1 Han

Figure 3  
Design materials in Revit
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After you bring a Revit 3D view into 3ds Max, you can use its Material Editor to refine the texture 

on objects whose materials are not translated properly. To minimize the number of objects that 

do not have the appropriate textures in 3ds Max, use materials with textures that use AccuRender 

bitmaps whenever possible.” (This information was found from Revit Architecture 2008 Help –Us-

er’s Guide). 

Google SketchUp 6

The author followed the research procedure typed “material” into the search from Google 

SketchUp 6 Help – online User’s Guide. 34 topics were found by SketchUP as relevant topics; 

however, the author only found two topics that are related to designing a material: Material 

Browser and Paint Bucket Tool (see Fig. 4).

The author also typed in “texture” and “mapping” and did not find new topics relevant to this 

research. The author found no unique terms. In addition, all the terms and phrases used in 

SketchUp are common in English and can be understood by designers without special training. 

The method of designing a basic material in SketchUp is explained below. 

“SketchUp contains a library of predefined materials that you can apply to faces and edges in 

your model. The Material Browser is used to organize materials and colors into libraries and to 

select and to apply materials to your model. 

Activate the Materials Browser either by clicking on the Paint Bucket Tool or by selecting Mate-

rial Browser from the Window menu.

Applying Materials

There are multiple methods to apply a material to entities in your model. To apply materials us-

ing the Paint Bucket Tool:

Select the Paint Bucket Tool. The cursor will change to a paint bucket. The Materials Browser 

will open. 

Click on the Select tab. 

Locate and click on a material library within the drop-down list. 

Click on the material you want to use. 

Click on a entity to apply the color or material to the entity. 

Editing Materials

Changes made a material will automatically apply to the entities in the model painted with that 

material. This behavior allows you to interactively experiment with color variations in your 

model. To edit a material:

Select the Materials menu item. The Materials Browser is displayed. 

Click on the Select tab. 
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Click on the In Model library drop-down list. 

Click on one of the materials. The material appears in the material thumbnail. 

Click on the Edit tab. 

Modify settings in any of the material. Refer the Edit Panel for further information. 

(optional) Save your changes to the edited material:

Click on the In Model button. The In Model library is displayed.

Context-click on the edited material. The In Model context-menu is displayed.

Select the Save As menu item. 

Navigate to a directory (folder) where you want to save the style. 

Type a name in the File name field and click the Save button. The file is saved. Refer to the Open 

or create a library context-menu item for information on how to retrieve this material for use in 

other SketchUp files.” (This information was found from SketchUp User’s Guide) 

3DS Max 2009

“Material” was typed into the search of Autodesk 3DS Max Help, and 500 topics were found by 

Max as relevant topics. This is to be expected due to the complexity of Max. Because of the 
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Figure 4
Search results of “material” in SketchUp
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large number of relevant topics, 20 random numbers were generated in order to reduce the time 

of reading all 500 topics (http://www.random.org/integers/, see Fig. 5). This number of ran-

domly generated numbers should be increased for a more precise study.  Twenty topics accord-

ing to the randomly generated numbers were analyzed as whether or not they are relevant to 

designing materials. These are the topics found through random selection: 

316 	 Blinn shader

163 	 3ds Max materials in mental ray renderings

71 		  Raytrace material

147 	 Using Multi/Sub-Object Materials with Particle Systems

407 	 Select By Material ID Dialog

22		  Raytrace Maps Rollout

28		  Materials and Linked Revit Objects

208	3	 D Displacement Shader (mental ray)

255		 Put to Library Dialog

219		 Schematic View Preferences Dialog

127		 Tiles Map (Appeared twice from random selection)

268		 Plastic/Vinyl ProMaterial (mental ray)

170	 Cool

39	 Clean MultiMaterial Utility

129	 Make Material Copy

49	 Render to Texture: Baked Material Rollout

270	 Select Bitmap Image File Dialog

410	 Coordinates Rollout (3D)

404	 Lathe Modifier

Han
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* Images should be inserted right above the Figure 1-6 letterings in the paper.  

Figure 5
Random numbers generated by random.org
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Among these twenty topics, the author only found six topics that are not related to designing a 

material. They are topic 28, 255, 219 170, 129 and 404. The other fourteen topics are relevant 

to designing material or applying texture mapping. The relevant topics consist of 70% of all 

randomly selected topics. If one applies this ratio to the total number of 500 topics resulted from 

the search, the number of topics that are relevant will be 350. When “texture” and “mapping” 

were typed into search, 312 and 500 topics were found respectively by Max. The author did 

count how many topics are repeated with the search results of “material;” however, she ex-

pected both repeated topics and new topics from the new search. Given the large number of 

search results, the author is not able to determine the accurate number of relevant topics at this 

stage. The assumed number of relevant topics is between 300 and 500.

From reading the titles of twenty randomly generated topics, the author found four terms that 

are not common English words: Blinn, Raytrace, Mental Ray and ProMaterial. Among these four 

unique terms, Blinn is unique to Max (can also be found in Maya, which is another high-end 

software, but not in other softwares from this research), and Raytrace and Mental Ray are shared 

terms by many 3D rendering softwares.  ProMaterial is unique to Max; however, it is just an-

other name for mental ray materials. The previous assumption is that there are a minimum of 

300 and a maximum of 500 possible topics relevant to this research.  Twenty out of the total of 

300 to 500 were examined, and 4 unique terms were found. According to the law of probability, 

if there are 4 unique terms found out of 20 topics, there should be 60-100 of them existing in 

Max. However, it is expected that many of the unique terms resulting from different searches are 

repeated. The actual number should be smaller, but it is unknown at this stage.  

This initial finding showed the complexity of Max. The method of designing a basic material in 

3ds Max is too complex to be included in this paper. 

 

Maya 8.5 personal learning edition

“Material,” “texture” and “mapping” were typed into the search of a subcategory called “render-

ing and render setup” under Maya85 PLE Online Help. Many topics were found. The number is 

very large and has not been counted at the present time (see Fig. 6). However, it is apparent that 

the search result shares a lot of similarity with the search result of Max. The vocabulary found in 

the search results including “phong” and “Blinn,” which also appeared in the search results from 

Max. The method of designing a basic material in Maya is also too complex to be included in 

this paper. Similar to Max, the actual number of unique terms is virtually unknown at this stage 

of research.    

   

AutoCAD 2006 

The author found 13 relevant topics through search of “material”, “texture” and “mapping”: 

Materials Dialog Box

Define and Modify Material

Specify How to Apply the Map

paper #C2#1 Han
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Figure 6
Search results of “material” in Maya

Specify a Type of Map

Adjust Material Bitmap Placement Dialog Box   

New or Modify Granite Material Dialog Box

New or Modify Marble Material Dialog Box

New or Modify Wood Material Dialog Box

To change a material from matte to shiny

RMAT Command

Adjust UVW Coordinates Dialog Box

Mapping Dialog Box

Specify How to Apply the Map

Two unique terms in AutoCAD 2006 were found: RMAT and UVW. They are not common words 

in English. RMAT is unique to CAD. UVW is a common term shared by many 3D rendering 

software packages. 

The method of designing a basic material in AutoCAD is explained below. 
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“To define a new material 

Click View – Render- Materials

In the Materials dialog box, click New. 

In the New Standard Materials dialog box, enter a name in the Material Name box. 

The name must be unique and have no more than 16 characters. 

Set the color and specify a value for each of the following material attributes: Color/Pattern, 

Ambient, and Reflection, or specify material attributes for Roughness, Transparency, Refraction, 

and Bump Map. 

Set the color and value for Color/Pattern. 

Color is the base color reflected by the object, also known as diffuse reflection. The main (diffuse) 

color of the material can be viewed in the sample image. You can adjust the color with the 

Value and Color controls. 

Pattern is defined as a bitmap image that consists of an arrangement of pixels (picture elements). 

Patterns can include any bitmap file types supported by the program. 

Set the color and value for Ambient. 

The settings for Ambient adjust the material’s shadow color. The Ambient settings also determine 

the color reflected from ambient light. 

Set the color and value for Reflection. 

The Reflection settings determine the color of the reflected highlights, also known as specular 

reflection. 

. 

For Photo Raytrace, Value specifies the material’s coefficient of reflectivity. This is the amount of 

a reflected ray’s color to add to a surface where the ray strikes.

For a shiny effect, set the value for Reflection to 0.7, and set the value for Color to 0.3. If you 

want the color of the highlight to be white, move the Red, Green, and Blue sliders until each has 

a value of 1.

Set the value for Roughness. 

The Roughness setting determines the size of the reflected highlight. 

Set the value for Transparency. 

The Transparency setting can make all or part of an object transparent or translucent. 

Set the value for Refraction. 

The Refraction setting sets a refraction index for transparent materials. Refraction values have 

no effect unless you enter a nonzero value for Transparency.

paper #C2#1 Han
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Set the value for Bump Map. 

The Bump Map setting determines the brightness of a bump map object. Bump Map values are 

translated into apparent changes in the height of the surface of an object.

Click Preview to see if the values you specified produce the effect you want. 

Change the values and continue to preview your changes until you’re satisfied with the materi-

al’s appearance. Click OK. 

Render toolbar 

Command line: RMAT” (This information was found from AutoCAD 2006 Help) 

Data Analysis

Three aspects of material, texture and mapping were compared: 

A. Number of topics found to be relevant to designing materials through search;

B. Number of unique terms used by one software; and 

C. Unique terms created by software engineers (These terms are not common English words 

and may appear to be elusive to designers).

Han

Table 1
Comparison of topics and unique terms relevant to material and texture among 3D rendering softwares

Name 

of the software

Rhinoceros

Revit Architecture

Google SketchUp

3DS Max

Maya

AutoCAD

A. Number of relevant 

topics found through 

search

4+

4+

2+

300-500

Unknown, expected to 

be a big number

13

B. Unique terms used 

only by this software

None or limited number

2+

None or limited number

Unknown, expected to 

be a big number

Unknown, expected to 

be a big number

1+

C. Unique terms used 

only by software engi-

neers (not common 

English words)

	

None or limited number

		

1+

	

None or limited number

Unknown, expected to 

be a big number

Unknown, expected to 

be a big number

	

2+
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Conclusion

Given the focus of this research, the conclusions are only valid for the aspect of designing ma-

terials among those software packages included in this research. This table offers some insight 

into many aspects of those 3D software packages that are included in this research. It is evident 

that the bigger the number under category A is, the more complicated the software gets when 

it comes to designing materials. The figure in category A is the indicator of how complex the 

software is. Software packages rank from the most complex one to the simplest one: 1) 3ds 

Max and Maya, 2) AutoCAD, 3) Rhino and Revit, and 4) SketchUp. This paper suggests that the 

number under category C can be used as an indicator for how intuitive the software packages 

are to the designers. The reason behind it is that the more familiar the designers are with the 

vocabulary used in one software, the easier it is for them to use it. If a designer has to con-

stantly go to Help and search for a definition of one particular word, the software will not be 

intuitive to the designer. If this assumption can be verified by research from other disciplines, the 

following statement can be made: SketchUp and Rhino are the most intuitive software pack-

ages to the designers, followed by Revit, then by AutoCAD. Max and Maya are the most difficult 

ones to learn. The conclusion drawn from column B is that if someone has prior experience with 

the more complex software packages such as Max or Maya, it should be easy for them to learn 

other software packages. Among those software packages, SketchUp and Rhino are the easi-

est to learn, followed by AutoCAD and Revit.       

Future study

The result of this study can be used as the foundation for questionnaire to collect data from 

designers and design students regarding their learning experiences on various 3D graphic soft-

ware packages. The hypothesis such as “the higher percentage of phrases shared by design 

and software development, the easier for designers to learn the software” can be tested and 

verified. The study of material and texture among various software packages can be further 

complicated by plug-ins that are commonly used for these computer graphic software pack-

ages. For instance, V-Ray is available for Max, SketchUp, Maya, Rhino and Revit. Future study 

regarding how V-ray is incorporated to those stand-alone software packages is suggested.
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